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FEATURES 
Full featured evaluation board for the AD7606B 
On-board power supplies 
Standalone capability 
SDP-H1 compatible (EVAL-SDP-CH1Z (SDP-H1)) 
PC software for control and data analysis (download from the 

AD7606B product page) 
Time and frequency domain 

EVALUATION KIT CONTENTS 
EVAL-AD7606BFMCZ evaluation board 

ADDITIONAL EQUIPMENT NEEDED 
System demonstration platform (SDP)—high speed controller 

board (EVAL-SDP-CH1Z (SDP-H1)) 
PC running Windows Vista or Windows 7 with a USB 2.0 port 
DC/ac signal source 
SMB and USB cables 
External supply (optional) 

DOCUMENTS NEEDED 
AD7606B data sheet 
EVAL-AD7606BFMCZ user guide 
Schematics  
Layout files 
Bill of materials 

REQUIRED SOFTWARE 
AD7606B evaluation software 

EVALUATION BOARD DESCRIPTION 
The EVAL-AD7606BFMCZ is a full featured evaluation board 
that allows users to easily evaluate the features of the AD7606B 
analog-to-digital converter (ADC). The EVAL-AD7606BFMCZ 
can be controlled by the system demonstration platform controller 
board (EVAL-SDP-CH1Z (SDP-H1)). The EVAL-SDP-CH1Z 
(SDP-H1) allows the EVAL-AD7606BFMCZ to be controlled 
through the USB port of a PC using the AD7606B evaluation 
software. The software is available for download from the 
AD7606B product page. 

On-board components include an ADP7118 5 V, low noise low 
dropout regulator (LDO) and an ADR4525 high precision, 
band gap voltage reference. 

Full data on the AD7606B is available in the AD7606B data sheet, 
which must be consulted in conjunction with this user guide. Full 
details on the EVAL-SDP-CH1Z are available on the SDP-H1 
product page. 

EVALUATION BOARD PHOTOGRAPH 
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Figure 1.  
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QUICK START GUIDE 
To quickly evaluate the AD7606B ADC, take the following 
steps:  

1. Install the evaluation software from the AD7606B product 
pages. Ensure that the EVAL-SDP-CH1Z (SDP-H1) is 
disconnected from the USB port of the PC while installing 
the software. Restart the PC after the installation process 
completes. For complete software installation instructions, 
see the Software Installation section. 

2. Ensure that the various link options are configured as 
outlined in Table 2.  

3. Connect the EVAL-SDP-CH1Z (SDP-H1) board to the 
EVAL-AD7606BFMCZ. Ensure that these boards are 
connected firmly together.  

4. By default, the power for the EVAL-AD7606BFMCZ is 
supplied by the EVAL-SDP-CH1Z (SDP-H1) controller 
board. A number of power options are available, see the 
Power Supplies section for more information. 

5. Connect the EVAL-SDP-CH1Z (SDP-H1) to the 12 V 
supply and to the PC via the USB cable. Choose to 
automatically search for the drivers for the EVAL-SDP-
CH1Z (SDP-H1) if prompted by the operating system. 

6. Launch the evaluation software from the Analog Devices 
subfolder in the Programs menu. 

7. Connect an input signal via the CH1 to CH8 terminal 
blocks. 
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EVALUATION BOARD HARDWARE 
DEVICE DESCRIPTION 
The AD7606B is a 16-bit, 8-channel, simultaneous sampling 
successive approximation ADC. The device operates from a single 
4.75 V to 5.25 V power supply and features throughput rates of 
up to 800 kSPS. The device has 5 MΩ input impedance for 
direct connection from the user sensor outputs to the ADC. 

HARDWARE LINK OPTIONS 
Table 2 details the link option functions and the default power 
link options. The EVAL-AD7606BFMCZ can be powered by 
different sources, as described in the Power Supplies section. By 
default, the power supply required for the EVAL-AD7606BFMCZ 
comes from the EVAL-SDP-CH1Z (SDP-H1) controller board. 
The power supply is regulated by the on-board ADP7118 low 
dropout (LDO) regulators, which generates the 5 V supply.  

CONNECTORS AND SOCKETS 
The connectors and sockets on the EVAL-AD7606BFMCZ are 
outlined in Table 1. 

Table 1. On-Board Connectors  
Connector Function 
P12 FPGA mezzanine card (FMC) connector  
P4 External power terminal block, 7 V to 9 V dc input 
P6, P8 8-pin connectors for input to Channel 1 through 

Channel 4 
P9, P10 8-pin connectors for input to Channel 5 through 

Channel 8 
J1 to J4 Analog input Subminiature Version B (SMB) 

connectors to Channel 1 through Channel 4 
P7, P11 Channel 8 surfboard evaluation headers 
P1, P2 General connectors for debugging purposes or to 

connect an external controller 

The default interface to the EVAL-AD7606BFMCZ is via the 
FMC connector, which connects the EVAL-AD7606BFMCZ to 
the EVAL-SDP-CH1Z (SDP-H1). 

POWER SUPPLIES 
Before applying power and signals to the EVAL-AD7606BFMCZ, 
ensure that all link positions are set according to the required 
operating mode. See Table 2 for the complete list of link 
options. 

The supply required for the EVAL-AD7606BFMCZ comes from 
the EVAL-SDP-CH1Z (SDP-H1) controller board. Alternatively, 
the EVAL-AD7606BFMCZ can also be supplied with a dc 
power supply connected to the P4 terminal block. Select the 
external power supply or the EVAL-SDP-CH1Z (SDP-H1) 
supply through JP2. The power supply is then connected to the 
on-board ADP7118 5 V linear regulator that supplies the correct 
bias to each of the various sections on the EVAL-
AD7606BFMCZ.  

CHANNEL INPUT 
The J1 to J4 connectors allow users to connect external signals 
to the ADC channel inputs through the SMB inputs. The EVAL-
AD7606BFMCZ is supplied with the AD7606B mounted (U4, 
see Figure 1). The AD7606B is an 8-channel data acquisition 
system (DAS) with a simultaneous sampling ADC. External 
signals can be applied to the P8 to P10 terminal blocks on the 
EVAL-AD7606BFMCZ. 

 

 

 

 

 

Table 2. Link Options 
Link Default Position Function 
JP2 A This link selects the power supply source for the evaluation board. 
  In Position A, the unregulated supply to the on-board LDOs is taken from the EVAL-SDP-CH1Z (SDP-H1) 12 V 

supply. 
  In Position B, the unregulated external supply to the on-board LDOs is taken from the P4 terminal block 

connector. 
JP1 A The EVAL-AD7606BFMCZ evaluation software controls the STBY pin. When using the EVAL-AD7606BFMCZ board 

in standalone mode without running the EVAL-AD7606BFMCZ evaluation software, this jumper allows selection 
of standby mode. In this case, change the R8 and R10 resistors to 0 Ω links. 

  In Position A, the STBY pin is tied to VDRIVE. 

  In Position B, the STBY pin is tied to AGND. 
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Link Default Position Function 
JP3 A Use to select the VDRIVE source for the AD7606B. 
  In Position A, the AD7606B is supplied with 3.3 V VDRIVE from the ADP7118.  
  In Position B, the AD7606B is supplied with 3.3 V from the EVAL-SDP-CH1Z (SDP-H1). 

JP4 A The EVAL-AD7606BFMCZ evaluation software controls the RANGE pin. If using the EVAL-AD7606BFMCZ board in 
standalone mode, this jumper allows selection of the analog input range in hardware mode. In this case, 
change the R20 resistor to a 0 Ω link.  

  In Position A, the RANGE pin is tied to VDRIVE, and the ±10 V range is selected. 

  In Position B, the RANGE pin is tied to AGND, and the ±5 V range is selected. 

  In software mode, this pin is ignored. 

JP5 A The EVAL-AD7606BFMCZ evaluation software controls the PAR/SER SEL pin. If using the EVAL-AD7606BFMCZ 
board in standalone mode, this jumper allows digital interface selection. In this case, change the R19 and R21 
resistors to 0 Ω links 

  In Position A, the PAR/SER SEL pin is tied to VDRIVE, and the serial interface is selected. 

  In Position B, the PAR/SER SEL pin is tied to AGND, and the parallel interface is selected. 

JP6 A The EVAL-AD7606BFMCZ evaluation software controls the REF SELECT pin. By default, the internal reference is 
selected. If switching to the external reference is required through the EVAL-AD7606BFMCZ evaluation 
software, R1 must be populated. If using the EVAL-AD7606BFMCZ board in standalone mode, this jumper allows 
reference selection. In this case, change the R13 resistor to a 0 Ω link. 

  In Position A, the REF SELECT pin is tied to VDRIVE, and the internal reference is enabled and selected. R1 must be 
unpopulated. 

  In Position B, the REF SELECT pin is tied to AGND, the internal reference is disabled, and the external reference is 
selected. R1 must be populated. 

S1 Open The EVAL-AD7606BFMCZ evaluation software controls the REF SELECT pin. If using the EVAL-AD7606BFMCZ in 
standalone mode, these switches can select the logic level on the OSx pins. 
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EVALUATION BOARD SOFTWARE 
SOFTWARE INSTALLATION 
The EVAL-AD7606BFMCZ kit software is available for download 
from the AD7606B product page. Both the EVAL-AD7606BFMCZ 
software and the EVAL-SDP-CH1Z (SDP-H1) board drivers 
must be installed. 

Warning 

The EVAL-AD7606BFMCZ evaluation software and drivers 
must be installed before connecting the EVAL-AD7606BFMCZ 
evaluation board and the EVAL-SDP-CH1Z (SDP-H1) board to 
the USB port of the PC to ensure that the evaluation system is 
correctly recognized when it is connected to the PC. 

Installing the EVAL-AD7606BFMCZ Evaluation Software 

To install the EVAL-AD7606BFMCZ evaluation software, take 
the following steps: 
1. Unzip the installer downloaded from the AD7606B 

product page. 
2. Double click the setup.exe file to begin the installation. 

By default, the software is saved to: C:\Program Files > 
Analog Devices > AD7606B. 

3. A dialog box appears asking for permission to allow the 
program to make changes to the PC. Click Yes to begin the 
installation process (see Figure 2). 
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Figure 2. User Account Control Dialog Box 

 

4. Select a location to install the software and then click Next 
(see Figure 3). 
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Figure 3. Destination Directory Window 

5. A license agreement then appears. Read the agreement, 
select I accept the License Agreement, and click Next. 

6. A summary of the installation appears. Click Next to 
continue (see Figure 4). 
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Figure 4. Start Installation Window 
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7. A dialog box informs the user when the EVAL-
AD7606BFMCZ evaluation software installation is 
complete (see Figure 5). Click Next to proceed with the 
installation of the SDP drivers.  
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Figure 5. Installation Complete Window 

Installing the SDP Board Drivers 

After the EVAL-AD7606BFMCZ evaluation software installation 
is complete, the ADI SDP Drivers 1.4.1.0. Setup Wizard window 
opens to install the EVAL-SDP-CH1Z (SDP-H1) board drivers as 
follows: 

1. When the ADI SDP Drivers 1.4.1.0. Setup Wizard opens, 
click Next to begin the driver installation process (see 
Figure 6). 
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Figure 6. Setup Wizard Welcome Window 

2. Select a destination folder for the SDP drivers and click 
Install (see Figure 7). 
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Figure 7. Choose Install Location Window 

3. Click Install again to proceed with the installation 
(see Figure 8). 
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Figure 8. Windows® Security Dialog Box 

4. When the SDP drivers installation completes, click Finish 
(see Figure 9). 

16
42

8
-0

0
9

 
Figure 9. Completion of Installation Window 

After the EVAL-AD7606BFMCZ evaluation software installation 
and SDP drivers installation is complete, connect the EVAL-
AD7606BFMCZ to the EVAL-SDP-CH1Z (SDP-H1) as described 
in the Evaluation Board Hardware section.  
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When first plugging in the EVAL-SDP-CH1Z (SDP-H1) via the 
USB cable provided, allow the Found Hardware Wizard to run. 
After the drivers are installed, ensure that the EVAL-SDP-CH1Z 
(SDP-H1) is connected correctly by looking at the Device 
Manager of the PC. The Device Manager can be found by right 
clicking My Computer > Manage > Device Manager from the 
list of System Tools. 

The Analog Devices SDP-H1 (EVAL-SDP-CH1Z (SDP-H1)) 
appears under ADI Development Tools, as shown in Figure 10. 
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Figure 10. Device Manager Window 

LAUNCHING THE SOFTWARE 
The EVAL-AD7606BFMCZ evaluation software can be launched 
when the EVAL-AD7606BFMCZ and the EVAL-SDP-CH1Z 
(SDP-H1) controller board are correctly connected to the PC. 

To launch the EVAL-AD7606BFMCZ evaluation software, take 
the following steps: 

1. From the Start menu, go to Programs < Analog Devices < 
AD7606B Eval. The main window of the software then 
displays (see Figure 12). 

2. If the EVAL-AD7606BFMCZ evaluation system is not 
connected to the USB port via the EVAL-SDP-CH1Z (SDP-
H1) board when the software launches, the Select 
Interface… dialog box appears (see Figure 11). Connect the 
EVAL-AD7606BFMCZ to the USB port of the PC, wait a 
few seconds, and then click Refresh to rescan the USB ports. 
When the connection is established, the AD7606BFMCZ 
Evaluation Board lists in the box. Then, click Select to 
proceed or Cancel to exit the software. 
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Figure 11. Select Interface … Dialog Box 
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Figure 12. EVAL-AD7606BFMCZ Evaluation Software Main Window 

DESCRIPTION OF MAIN WINDOW 
The main window of the software displays the controls and 
analysis indicators of the EVAL-AD7606BFMCZ evaluation 
software, allowing the user to control the operation of the 
software and the capturing and displaying of data from the 
ADC. When the software launches, the main EVAL-
AD7606BFMCZ evaluation software window opens (see 
Figure 12). 

The main EVAL-AD7606BFMCZ evaluation software window 
shown in Figure 12 has the following features: 

 Menu bar. 
 Control buttons. 
 Configuration tab, Waveform tab, FFT tab, and 

Histogram tab.  

Note that if software mode is selected, the Registers tab also 
appears in the main EVAL-AD7606BFMCZ evaluation software 
window. 

MENU BAR 
The menu bar (see Figure 12) consists of the File and Help menus. 

The File menu includes the following options: 

 The Save Data option saves captured data, from all eight 
channels, in comma separated value (.csv) format for 
future analysis. 

 The Load Data option loads previously captured data in 
.csv format for analysis. 

 The Exit option exits the program. 

The Help menu includes an Analog.com link option. 

CONFIGURATION TAB 
The Configuration tab contains controls to configure the 
AD7606B. Available controls include the sampling rate, 
operating mode (hardware or register), data interface, range, 
and oversampling. 

Sampling Rate 

Use the Sampling Rate (sps) field in Figure 12 to increase the 
rate of the converted start pulses to the AD7606B. This control 
accepts values from 3052 SPS to 800,000 SPS on the AD7606B. 
To achieve 800 kSPS, use the parallel interface in both hardware 
and software mode. When using the serial interface, to achieve 
800 kSPS, users must select software mode, and DOUT_FORMAT 
must be configured as four lines in the CONFIG register within 
the Registers tab. 
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Figure 13. Use the DOUT_FORMAT Configuration in the Registers Tab to 

Achieve High Throughput Rates in the Serial Interface 

If oversampling is enabled, the maximum sampling limit is 
decreased. Next time the Sampling rate (sps) field is written to 
after changing the oversampling ratio, this field automatically 
overwrites the maximum sampling frequency if attempting to 
write a higher value. 
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Parallel/Serial 

The Parallel/Serial dropdown menu in Figure 12 allows users 
to select between a serial or parallel interface. When changing 
the interface, the software automatically resets the AD7606B. 

REF Select 

The REF Select dropdown menu in Figure 12 allows users to 
select between an internal and an external reference. When 
changing the interface, the software automatically resets the 
AD7606B. To use the external reference, R1 must be populated 
on the PCB. 

Mode 

The Mode dropdown menu in Figure 12 allows users to select 
between hardware or software mode. If software mode is 
selected, the software sets all oversampling pins high, and the 
Register tab enables granting access to the whole memory map. 
If hardware mode is selected, there is no memory map available. 
Therefore, the range and oversampling modes are only selected 
through the corresponding pins. To configure these pins, Range 
and Oversampling mode dropdown menus enable in hardware 
mode. 

Range 

The Range dropdown menu in Configuration tab, which is 
enabled in hardware mode, allows users to select the RANGE 
pin logic level and the range used by the software. The signal 
analysis calculations for the Histogram, Waveform, and FFT 
tabs are then calculated according to the range selected.  

Oversample Mode 

The Oversample Mode dropdown menu in Configuration tab, 
which is enabled in hardware mode, allows users to enable or 
disable oversampling and to choose from oversampling rates of 
2, 4, 8, 16, 32, and 64. See the AD7606B data sheet for more 
information on the digital filter profile. The maximum output data 
rate of the AD7606B is limited by the selected oversampling rate. 

Samples 

The user can select the number of samples captured from the 
Samples dropdown menu in Figure 12. The default number of 
samples is 32768. However, the number of samples can be 
changed through the dropdown menu. 

Taking Samples 

To initiate the conversion process and capture the sampled data, 
click Sample.  

When Sample is clicked, the software instructs the EVAL-SDP-
CH1Z (SDP-H1) board to take the required number of samples 
at the required sampling rate from the EVAL-AD7606BFMCZ. 
After the required number of samples are captured, the capturing 
process stops, and the data displayed in the Waveform, 
Histogram, or FFT tabs updates. 

When Continuous is clicked, the label on this button changes 
to Stop, and the software repeats the capture of the selected 
number of samples indefinitely until the user clicks Stop. While 
the software is in the continuous capture mode, the data in the 
Waveform, Histogram, or FFT tab is also continuously 
updated.  
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WAVEFORM TAB 
Waveform Graph and Controls 

The Waveform tab (see Figure 15) shows each successive 
sample of the ADC output. The control tools on the bottom 
right in the Waveform graph (see Figure 14) allow the user to 
zoom in on the data. Change the scales on the graph by typing 
values into the x-axis and y-axis. 

1. USED FOR CONTROLLING
    THE CURSOR IF PRESENT.
2. USED FOR ZOOMING IN AND OUT.
3. USED FOR PANNING.

1 2 3
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Figure 14. Chart Tools  

Channel Selection 

The channel selection control (Analysis Ch dropdown box) allows 
the user to choose which channels display in the waveform 
analysis section. These controls only affect the display of the 
channels, and do not have any effect on the channel settings in 
the ADC register map. 

 

Display Units and Axis Controls 

Use the display units dropdown menu (see Units: Volts in 
Figure 15) to select whether the data graph displays in units of 
voltages or codes. Note that this selection affects both the 
waveform graph and the histogram graph.  

If the unit is selected as Code (Hex), the x-axis of the graph 
shows the original data (twos complement). 

The axis controls can be switched between dynamic and fixed. 
When dynamic is selected, the axis automatically adjusts to show 
the entire range of the ADC results after each batch of samples. 
When fixed is selected, the user can program the axis ranges 
manually, and the ranges do not adjust automatically after each 
sample batch. 

Save Data 

Click Captured Data to save the samples to an external file. 

Waveform Analysis 

The Waveform Analysis section displays the results of the noise 
analysis for the selected analysis channel in the Analysis Ch 
dropdown menu. 
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Figure 15. Waveform Tab 
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AC TESTING—FAST FOURIER TRANSFORM (FFT) 
CAPTURE 
Figure 16 shows the FFT tab. The FFT tab analyzes the 
performance of an ADC in the frequency domain. The FFT tab 
tests the traditional ac characteristics of the converter and displays 
a FFT of the results. The FFT tab shows a plot of the computed 
FFT data. 

The FFT Analysis pane contains additional information about the 
analysis, such as the calculated values of signal-to-noise ratio 
(SNR), signal-to-noise-and-distortion (SINAD), and total 
harmonic distortion (THD) (see Figure 16).  

The user can choose to display the information for one, several, 
or all eight channels in the FFT tab using the checkboxes beside 
each channel. 
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Figure 16. FFT Tab 
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HISTOGRAM TAB 
Histogram and Controls 

The data histogram shows the number of times each sample of 
the ADC output occurs (see Figure 17). The control tools in the 
graph allow the user to zoom in on the data. Change the scales 
on the graph by typing values into the x-axis and y-axis. 

Histogram Analysis 

The Histogram Analysis section shows the analysis of the 
channel selected via the Analysis Ch control. 
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Figure 17. Histogram Tab  
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REGISTERS TAB 
Register Tree  

The register tree on the left side of Figure 18 shows the full 
register map in a tree control. Each register is shown. Click the 
expand button next to each register to show the bitfields 
contained within that register.  

Register Control  

The Register control allows the user to change the individual 
bits of the register selected in the register tree. Click on each bit to 
toggle the value or to program the register value directly into 
the number control field on the right.  

Bitfields List  

The Bitfields list shows the bitfields of the register selected in 
the register tree, for example, the Channel 1 and Channel 2 
input range in Figure 18. The values can be changed using the 
dropdown box or by entering a value directly into the numeric 
control on the right. 

Documentation  

The Documentation section contains the documentation for 
the register and bitfield selected in the register tree. 

Save and Load  

The Save button allows users to save the current register map 
setting to a file, and the Load button allows users to load the 
setting from the current register map setting file. 

EXITING THE SOFTWARE 
To exit the software, click Close at the top, right corner of the 
main window. 
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Figure 18. Registers Tab 
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SAVING FILES 
The EVAL-AD7606BFMCZ evaluation software can save the 
captured data for future analysis. The software can capture the 
current plot images and the current device configuration, as well as 
the raw waveform data, histogram data, and ac spectrum data. 

Saving Data 

To save data, go to the File menu and click Save Data (see 
Figure 19). This action saves the raw data captured as seen in 
the Waveform tab in tab separated value (.tsv) format. 
Alternatively, there is a button on each tab to save the data 
stored on each graph: waveform, FFT, or histogram. 
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Figure 19. Save As Data Dialog Box 

Saving Plot Images 

To save plot images, go to the Waveform tab, FFT tab, or 
Histogram tab, click the File menu, and then click Save As 
Picture.  

The images are saved in .jpeg format and do not contain any 
raw data information. Plots saved as images cannot be loaded 
back into the evaluation environment. 
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NOTES 
 

 

 

ESD Caution  
ESD (electrostatic discharge) sensitive device. Charged devices and circuit boards can discharge without detection. Although this product features patented or proprietary protection 
circuitry, damage may occur on devices subjected to high energy ESD. Therefore, proper ESD precautions should be taken to avoid performance degradation or loss of functionality. 

Legal Terms and Conditions 
By using the evaluation board discussed herein (together with any tools, components documentation or support materials, the “Evaluation Board”), you are agreeing to be bound by the terms and conditions set 
forth below (“Agreement”) unless you have purchased the Evaluation Board, in which case the Analog Devices Standard Terms and Conditions of Sale shall govern. Do not use the Evaluation Board until you have 
read and agreed to the Agreement. Your use of the Evaluation Board shall signify your acceptance of the Agreement.  This Agreement is made by and between you (“Customer”) and Analog Devices, Inc. (“ADI”), 
with its principal place of business at One Technology Way, Norwood, MA 02062, USA. Subject to the terms and conditions of the Agreement, ADI hereby grants to Customer a free, limited, personal, temporary, 
non-exclusive, non-sublicensable, non-transferable license to use the Evaluation Board FOR EVALUATION PURPOSES ONLY. Customer understands and agrees that the Evaluation Board is provided for the sole and 
exclusive purpose referenced above, and agrees not to use the Evaluation Board for any other purpose. Furthermore, the license granted is expressly made subject to the following additional limitations: Customer 
shall not (i) rent, lease, display, sell, transfer, assign, sublicense, or distribute the Evaluation Board; and (ii) permit any Third Party to access the Evaluation Board. As used herein, the term “Third Party” includes any 
entity other than ADI, Customer, their employees, affiliates and in-house consultants. The Evaluation Board is NOT sold to Customer; all rights not expressly granted herein, including ownership of the Evaluation 
Board, are reserved by ADI. CONFIDENTIALITY. This Agreement and the Evaluation Board shall all be considered the confidential and proprietary information of ADI. Customer may not disclose or transfer any 
portion of the Evaluation Board to any other party for any reason. Upon discontinuation of use of the Evaluation Board or termination of this Agreement, Customer agrees to promptly return the Evaluation Board 
to ADI. ADDITIONAL RESTRICTIONS. Customer may not disassemble, decompile or reverse engineer chips on the Evaluation Board. Customer shall inform ADI of any occurred damages or any modifications or 
alterations it makes to the Evaluation Board, including but not limited to soldering or any other activity that affects the material content of the Evaluation Board. Modifications to the Evaluation Board must comply 
with applicable law, including but not limited to the RoHS Directive. TERMINATION. ADI may terminate this Agreement at any time upon giving written notice to Customer. Customer agrees to return to ADI the 
Evaluation Board at that time. LIMITATION OF LIABILITY. THE EVALUATION BOARD PROVIDED HEREUNDER IS PROVIDED “AS IS” AND ADI MAKES NO WARRANTIES OR REPRESENTATIONS OF ANY KIND WITH 
RESPECT TO IT. ADI SPECIFICALLY DISCLAIMS ANY REPRESENTATIONS, ENDORSEMENTS, GUARANTEES, OR WARRANTIES, EXPRESS OR IMPLIED, RELATED TO THE EVALUATION BOARD INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY, TITLE, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF INTELLECTUAL PROPERTY RIGHTS. IN NO EVENT WILL ADI AND ITS 
LICENSORS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES RESULTING FROM CUSTOMER’S POSSESSION OR USE OF THE EVALUATION BOARD, INCLUDING BUT NOT LIMITED 
TO LOST PROFITS, DELAY COSTS, LABOR COSTS OR LOSS OF GOODWILL. ADI’S TOTAL LIABILITY FROM ANY AND ALL CAUSES SHALL BE LIMITED TO THE AMOUNT OF ONE HUNDRED US DOLLARS ($100.00). 
EXPORT. Customer agrees that it will not directly or indirectly export the Evaluation Board to another country, and that it will comply with all applicable United States federal laws and regulations relating to 
exports. GOVERNING  LAW. This Agreement shall be governed by and construed in accordance with the substantive laws of the Commonwealth of Massachusetts (excluding conflict of law rules). Any legal action 
regarding this Agreement will be heard in the state or federal courts having jurisdiction in Suffolk County, Massachusetts, and Customer hereby submits to the personal jurisdiction and venue of such courts. The 
United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement and is expressly disclaimed. 

©2019 Analog Devices, Inc. All rights reserved. Trademarks and  
 registered trademarks are the property of their respective owners. 
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